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Note pour les utilisateurs Mac

Certaines combinaisons de touches et certains éléments de menus sont différents entre un Mac et 
Windows ou Linux. La table ci-dessous donne quelques équivalents pour les instructions de ce 
chapitre. Pour une liste plus détaillée, voyez dans l'Aide.

Windows/Linux Équivalent Mac Effet

Sélection de menu 
Outils > Options

LibreOffice > Préférences Accès aux options de paramétrage

Clic droit ⌘+clic Ouvre un menu contextuel

Ctrl (Contrôle) ⌘ (Commande) Utilisé avec d'autres touches

F5 Maj+⌘+F5 Ouvre le Navigateur

F11 ⌘+T Ouvre la fenêtre Styles & Formatage
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Introduction

Vous pouvez saisir des données dans Calc de différentes manières : en utilisant le clavier, la 
souris (glisser et déposer), l'outil Remplir et les listes de sélection. Calc donne également la 
possibilité d'entrer de l'information dans plusieurs feuilles d'un même document en une seule fois.

Vous pouvez formater les données saisies et les afficher de plusieurs façons.

Saisir des données en utilisant le clavier

La plupart des saisies de données dans Calc peuvent être faites en utilisant le clavier.

Saisir des nombres
Cliquez dans la cellule et tapez le nombre en utilisant les touches numériques soit de la partie 
principale du clavier, soit du pavé numérique.

Pour entrer un nombre négatif, tapez le signe moins (–) devant lui ou entourez-le de parenthèses, 
comme ceci : (1234).

Par défaut, les nombres sont alignés à droite et les nombres négatifs commencent par le signe 
moins.

Saisir des textes
Cliquez dans la cellule et tapez le texte. Les textes sont alignés à gauche par défaut.

Pour saisir un texte de plusieurs lignes dans une cellule, vous pouvez insérer des retours à la ligne
en tapant Ctrl+Entrée.

Vous pouvez agrandir la zone de saisie en cliquant sur l'icône Étendre la barre Formule . La 

zone de saisie devient alors multilignes (Figure 1). Cliquez à nouveau sur l'icône  pour revenir à 
la zone de saisie initiale.

Figure 1 : Zone de saisie multilignes

Saisir des nombres en tant que textes
Si un nombre est saisi dans le format 01481, Calc supprimera le 0 devant ce nombre. (Exception : 
voir l'Astuce ci-dessous.) Pour conserver le 0 de devant, par exemple pour un numéro de 
téléphone, vous pouvez soit :

• assigner le format texte à la cellule (Format > Cellules > Nombres et choisir la catégorie 
Texte) et taper ensuite le nombre, comme ceci : 01481 ;

• taper une apostrophe (guillemet simple) devant le nombre, comme ceci : '01481. 
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La donnée est désormais traitée comme un texte et est affichée exactement comme elle a été 
saisie. Par conséquent, les formules considéreront cette saisie comme un zéro et les fonctions 
l'ignoreront.

Astuce

Les nombres peuvent commencer par des zéros et être toujours considérés 
comme des nombres (et non comme des textes) si la cellule est formatée de façon
appropriée. Faites un clic droit dans la cellule et choisissez Formater les cellules 
> Nombres. Ajustez le paramétrage Zéros non significatifs pour ajouter des zéros 
au début des nombres.

Note

Quand une apostrophe est utilisée pour permettre l'affichage d'un 0 au début d'un 
nombre, elle n'est pas visible dans la cellule dès lors que la touche Entrée est 
appuyée. Si des “guillemets intelligents” sont utilisés comme apostrophes, 
l'apostrophe restera visible dans la cellule.

Pour choisir ce type d'apostrophe, utilisez Outils > Options d'AutoCorrection > 
Options linguistiques. Cochez Remplacer les guillemets simples pour activer 
cette fonction. La sélection du type de guillemet simple s'appliquera à la fois à 
Calc et à Writer.

Attention Quand un nombre est formaté en tant que texte, prenez garde à ce que la cellule 
contenant ce nombre ne soit pas utilisée dans une formule, parce que Calc 
ignorera sa valeur.

Saisir des dates et des heures
Sélectionnez la cellule et tapez la date ou l'heure. Vous pouvez séparer les éléments de la date 
avec un slash (/) ou un tiret (–) ou utiliser un texte comme 10 octobre 03. Calc reconnaît plusieurs 
formats de date. Vous pouvez séparer les éléments de temps avec des deux-points comme 
10:43:45.

Les formats de dates reconnus par Calc peuvent être définis dans l'option Motifs d'acceptation de 
date dans Outils > Options > Paramètres linguistiques > Langues, avec les notations 
suivantes : D pour le jour, M pour le mois et Y pour l’année.

Astuce

Les raccourcis clavier Ctrl+; et Maj+Ctrl+; permettent d'entrer la date et l'heure 
courante dans la cellule, respectivement formatées en date et en heure. L'entrée 
est effectuée sous forme de valeur. N'étant pas des fonctions ou des champs, les 
données ne sont pas actualisées par la suite.

En interne, LibreOffice traite les valeurs de date ou d'heure en tant que valeurs numériques. Si 
vous assignez le format numérique Nombre à une valeur de date ou d'heure, celle-ci est convertie 
en un nombre. Par exemple, 01/01/2000 12:00 PM est converti en 36526,5. La valeur précédant la
virgule correspond à la date, et la valeur suivant la virgule correspond à l'heure. Si vous ne 
souhaitez pas voir ce type de représentation de la date ou de l'heure, sélectionnez la cellule 
contenant la valeur, faites un clic droit et sélectionnez Formater les cellules dans le menu 
contextuel. Dans l'onglet Nombres, choisissez la catégorie Date ou Heure.
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Saisir des caractères spéciaux
Un caractère “spécial” est un caractère qui ne se trouve pas sur un clavier français standard. Par 
exemple, © ¾ æ ñ ö ø ¢ sont tous des caractères spéciaux. Pour insérer un caractère spécial :

1) Placez le curseur dans votre document où vous voulez que le caractère apparaisse.

2) Cliquez sur Insertion > Caractères spéciaux pour ouvrir la boîte de dialogue Caractères 
spéciaux (Figure 2).

3) Sélectionnez un ou plusieurs caractères (depuis une police ou un sous-ensemble de 
polices) que vous voulez insérer ; puis cliquez sur OK. Les caractères sélectionnés sont 
affichés en bas à gauche de la boîte de dialogue. Quand vous sélectionnez un caractère, il 
est affiché seul à droite, avec son code numérique associé.

Note
Les différentes polices comprennent des caractères spéciaux différents. Si vous 
ne trouvez pas le caractère spécial particulier que vous voulez, essayez de 
changer la sélection de Police.

Figure 2 : Boîte de dialogue Caractères spéciaux

Insérer des tirets
Pour saisir des tirets moyens et longs, vous pouvez utiliser l'option Remplacer les tirets dans 
l'onglet Outils > Options d'AutoCorrection > Options. Cette option remplace deux traits d'union, 
sous certaines conditions, par le tiret correspondant.

Dans la table suivante, A et B représentent un texte constitué de lettres de A à z et de chiffres de 0 
à 9.
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Texte que vous tapez : Résultat

A - B (A, espace, moins, espace, B) A – B (A, espace, tiret moyen, espace, B)

A -- B (A, espace, moins, moins, espace, B) A – B (A, espace, tiret moyen, espace, B)

A--B (A, moins, moins, B) A—B (A, tiret long, B)

A-B (A, moins, B) A-B (sans modification)

A -B (A, espace, moins, B) A -B (sans modification)

A --B (A, espace, moins, moins, B) A –B (A, espace, tiret moyen, B)

Désactiver les changements automatiques
Calc applique automatiquement plusieurs changements durant la saisie de données, à moins que 
vous n'ayez désactivé ces changements. Vous pouvez également annuler immédiatement chaque 
changement automatique avec Ctrl+Z.

Changements de l'AutoCorrection
La correction automatique des erreurs de frappe, le remplacement des guillemets doubles 
droits par des apostrophes courbes et le début de contenu de cellule avec une lettre majuscule
sont contrôlés par Outils > Options d'AutoCorrection. Allez dans les onglets Options ou 
Remplacer pour désactiver chaque caractéristique indésirable. Dans l'onglet Remplacer, vous 
pouvez également supprimer les paires de mots non souhaitées et ajouter de nouvelles paires.

AutoSaisie
Quand vous tapez du texte dans une cellule, Calc suggère automatiquement une occurrence 
trouvée dans la même colonne. Pour activer ou désactiver l'AutoSaisie, affichez ou enlevez 
une coche devant Outils > Contenu des cellules > AutoSaisie.

Conversion automatique des dates
Calc convertit automatiquement certaines saisies en dates. Pour s'assurer qu'une saisie qui 
ressemble à une date est considérée comme un texte, formatez la cellule en texte ou tapez 
une apostrophe au début de la saisie.

Accélérer la saisie des données

La saisie de données dans un classeur peut demander beaucoup de travail, mais Calc fournit 
plusieurs outils pour alléger certaines corvées de saisie.

La fonctionnalité la plus simple est de faire glisser et déposer le contenu d'une cellule dans une 
autre avec la souris. Beaucoup de personnes trouvent également utile l'AutoSaisie. Calc recèle 
également plusieurs autres outils pour la saisie automatique, plus particulièrement pour les tâches 
répétitives. Ce sont l'outil Remplir, les listes de sélection et la possibilité de saisir de l'information 
dans plusieurs feuilles du document.
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Utiliser l'outil Remplir dans les cellules
Au plus simple, l'outil Remplir est une façon de dupliquer un contenu existant. Commencez par 
sélectionner la cellule à copier, puis faites glisser la souris dans une direction (ou gardez appuyée 
la touche Maj et cliquez dans la dernière cellule que vous voulez remplir), et choisissez ensuite 
Édition > Remplir et la direction dans laquelle vous voulez effectuer la copie : Vers le haut, Vers le
bas, À gauche ou À droite (Figure 3).

Attention Les choix qui ne sont pas valables sont grisés, mais vous pouvez toujours choisir 
la direction opposée à celle que vous souhaitez, ce qui peut avoir comme 
conséquence d'écraser accidentellement des cellules.

Astuce

Une manière rapide de remplir des cellules est de saisir la “poignée” dans le coin 
inférieur droit de la cellule et de la faire glisser dans la direction que vous voulez 
remplir. Si la cellule contient un nombre, alors des nombres rempliront les cellules 
selon une série. De même, si la cellule contient un texte, ce même texte remplira 
les cellules dans la direction que vous choisirez.

Figure 3 : Utiliser l'outil Remplir

Utiliser une série de remplissage
Une utilisation plus complexe de l'outil Remplir est d'utiliser une série de remplissage. Des listes 
par défaut existent pour les jours de la semaine, complets et abrégés, et les mois de l'année, mais 
vous pouvez également créer vos propres listes.

Pour ajouter une série de remplissage à un classeur, sélectionnez les cellules à remplir, choisissez
Édition > Remplir > Série. Dans la boîte de dialogue Remplir la série (Figure 4), sélectionnez 
Remplissage automatique comme Type de séries et entrez comme Valeur initiale un élément 
d'une série définie. Les cellules sélectionnées se rempliront alors en séquence avec les autres 
éléments de la liste, en se répétant depuis le début de la liste si la fin de la liste est atteinte (Figure
5).
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Figure 4 : Spécifier le début d'une série de remplissage (résultats dans la Figure 5)

Vous pouvez également utiliser le type de séries Linéaire de Édition > Remplir > Série pour 
créer une série de remplissage occasionnelle pour des nombres en saisissant les valeurs de début
et de fin et l'incrément. Par exemple, si vous saisissez les valeurs de début et de fin de 1 et 7 avec
un incrément de 2, vous obtiendrez la séquence 1, 3, 5, 7.

Le type de séries Géométrique vous permet de remplir les cellules sélectionnées selon une suite 
géométrique. Par exemple, si vous saisissez une valeur de début de 1 et un incrément de 2, vous 
obtiendrez la séquence 1, 2, 4, 8, 16.

Le type de séries Date vous permet de remplir les cellules sélectionnées selon une suite de dates. 
Les unités de temps Jour, Jour de la semaine, Mois et Année sont disponibles. Par exemple, si 
vous saisissez une valeur de début 13/02/13 et un incrément de 2 avec l'unité de temps Mois, 
vous obtiendrez la séquence 13/02/13, 13/04/13, 13/06/13, 13/08/13.

Figure 5 : Résultat de la sélection de la série de 
remplissage telle que Figure 4

Dans tous les cas, l'outil Remplir crée seulement une liaison momentanée entre les cellules. Une 
fois qu'elles sont remplies, les cellules n'ont plus de liaison entre elles.

Définir une série de remplissage
Pour définir votre propre série de remplissage, allez à Outils > Options > LibreOffice Calc > 
Listes de tri. Cette boîte de dialogue (Figure 6) affiche les séries précédemment définies dans le 
champ Listes sur la gauche, et le contenu de la liste en surbrillance dans le champ Entrées.
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Figure 6 : Séries de remplissage prédéfinies

Cliquez sur Nouveau. Le champ Entrées est mis à blanc. Tapez les valeurs de la nouvelle liste 
dans le champ Entrées (une entrée par ligne), et cliquez ensuite sur Ajouter (Figure 7).

Figure 7 : Définir une nouvelle série de remplissage

Vous pouvez également définir une série de remplissage à partir d'une plage de cellules. Pour 
ceci, sélectionnez la plage de cellules qui contient les valeurs de la série, allez à Outils > Options 
> LibreOffice Calc > Listes de tri et cliquez sur Copier. Si la plage comporte plus d'une ligne et 
plus d'une colonne, la boîte de dialogue Copier la liste s'ouvre, vous demandant d'indiquer si la 
série se trouve en ligne ou en colonne.
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Utiliser les listes de sélection
Les listes de sélection sont disponibles uniquement pour les textes et sont
limitées à l'usage de textes qui ont été déjà saisis dans la même colonne.

Pour utiliser une liste de sélection, sélectionnez une cellule vide et appuyez
sur Alt+↓ (flèche bas) (versions précédentes : Ctrl+D ou Ctrl+Maj+D), ou
faites un clic droit et choisissez Liste de sélection. Une liste déroulante
apparaît, contenant toutes les cellules de la même colonne qui ont au moins
un caractère de texte ou dont le format est défini comme texte. Les textes
des cellules sont triés par ordre alphabétique et ceux qui ont des
occurrences multiples n'apparaissent qu'une seule fois. Cliquez sur l'entrée
dont vous avez besoin.

Partager du contenu entre différentes feuilles
Vous pouvez vouloir entrer la même information dans la même cellule de
plusieurs feuilles, par exemple pour fixer des listes standard pour un groupe de personnes ou pour
des organismes. Au lieu de saisir la liste individuellement dans chaque feuille, vous pouvez la 
saisir en une fois pour toutes les feuilles. Pour ce faire, sélectionnez les feuilles désirées (Édition 
> Feuille > Sélectionner et cliquez sur le nom des feuilles désirées en maintenant la touche Ctrl 
enfoncée), puis saisissez l'information dans la feuille courante.

Attention Cette technique écrase toute information qui se trouve déjà dans les cellules des 
autres feuilles, sans aucun avertissement. Pour cette raison, quand vous avez fini,
assurez-vous de bien désélectionner toutes les feuilles sauf celle que vous voulez 
modifier. (Ctrl+clic sur un onglet pour sélectionner ou désélectionner la feuille.)

Fusionner des cellules

Vous pouvez sélectionner des cellules adjacentes et les fusionner en une seule. Pour ceci, vous 
pouvez sélectionner les cellules désirées et :

• sélectionner Format > Fusionner les cellules > Fusionner les cellules dans la barre de 
menus ;

• faire un clic droit et choisir Fusionner les cellules dans le menu contextuel.

Si une des cellules autre que la première est remplie, un message s'affiche, vous proposant de 
déplacer le contenu des cellules cachées dans la première cellule. Vous pouvez accepter (le 
contenu des cellules est concaténé avec un espace de séparation), refuser (le contenu des 
cellules autres que la première est masqué) ou annuler l'opération.

Vous pouvez également sélectionner Format > Fusionner les cellules > Fusionner et centrer 
les cellules dans la barre de menus, ou cliquer sur le bouton Fusionner et centrer les cellules 

 de la barre d'outils Formatage, pour fusionner les cellules et centrer le contenu résultant.

Pour annuler la fusion de cellules, sélectionnez la cellule fusionnée et choisissez Format > 
Fusionner les cellules > Scinder les cellules dans la barre de menus ou cliquez sur le bouton 

Fusionner et centrer les cellules de la barre d’outils Formatage .
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Valider le contenu des cellules

Quand vous créez des classeurs pour que d'autres personnes les utilisent, vous pouvez vouloir 
vous assurer qu'elles saisissent des données qui sont valides ou appropriées pour la cellule. Vous 
pouvez également utiliser la validation pour votre propre usage comme guide pour saisir des 
données complexes ou rarement utilisées.

Les séries de remplissage et les listes de sélection peuvent convenir pour certains types de 
données, mais elles sont limitées aux informations prédéfinies. Pour valider une nouvelle donnée 
saisie par un utilisateur, sélectionnez une cellule et utilisez Données > Validité pour définir le type 
de contenu qui peut être saisi dans cette cellule. Par exemple, une cellule peut nécessiter une date
ou un nombre entier, sans caractère alphabétique ni point décimal ; ou bien encore une cellule ne 
doit pas être laissée vide.

Selon le paramétrage de la validation, l'outil peut aussi définir l'intervalle des valeurs qui peuvent 
être saisies, et fournir des messages d'aide qui expliquent les règles de validation que vous avez 
paramétrées pour cette cellule (ce que les utilisateurs devraient faire s'ils saisissent un contenu 
incorrect). Vous pouvez aussi paramétrer la cellule pour refuser un contenu incorrect, l'accepter 
avec un avertissement, ou, si vous êtes très organisé, exécuter une macro si une erreur est saisie.

Notez qu'une règle de validité est considérée comme une partie du format de la cellule. Si vous 
sélectionnez Formats ou Tout supprimer depuis la boîte de dialogue Supprimer du contenu, alors
elle sera supprimée. Si vous voulez copier une règle de validité avec le reste de la cellule, utilisez 
Édition > Collage spécial > Formats ou Tout insérer.

Critères
La Figure 8 montre les choix possibles pour un test de validité ordinaire.

Figure 8 : Choix d'un test de validité ordinaire

Autoriser
Permet de choisir une option de validation dans la liste déroulante pour les cellules 
sélectionnées.

• Toutes les valeurs : pas de critère de validité.

• Nombres entiers : seuls les nombres entiers sont permis.
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• Décimal : tous les nombres sont permis.

• Date : seules les dates sont permises.

• Heure : seules les heures sont permises.

• Plage de cellules : seules les valeurs comprises dans une plage de cellules sont permises. 
Cette plage de cellules peut être spécifiée explicitement ou à travers une plage de données
ou une plage nommée. Elle devrait être constituée d'une colonne ou d'une ligne de 
cellules. Si elle comporte plusieurs lignes et plusieurs colonnes, seule la première colonne 
sera utilisée.

• Liste : seules les valeurs spécifiées dans une liste sont permises. Les nombres et les 
textes peuvent être mélangés. Les valeurs des nombres sont considérées 
indépendamment de leur format : si vous avez entré 1 dans la liste, la saisie de la valeur 
100 % sera considérée comme valide.

• Longueur du texte : seules les saisies dont le nombre de caractères correspond au critère 
sont permises.

Autoriser les cellules vides
Permet de spécifier si les cellules vides sont invalides.

Données
Permet de sélectionner un opérateur de comparaison dans la liste déroulante.

Valeur
Pour les opérateurs égal à et différent, saisissez la valeur considérée.

Minimum
Pour les opérateurs supérieur à, supérieur ou égal à, plage correcte ou plage incorrecte, 
saisissez la valeur minimum considérée.

Maximum
Pour les opérateurs inférieur à, inférieur ou égal à, plage correcte ou plage incorrecte, 
saisissez la valeur maximum considérée.

Les options d'un test de validité peuvent changer selon le type de données sélectionné dans la 
liste Autoriser. La Figure 9 montre la boîte de dialogue quand la validité s'effectue selon une plage 
de cellules.

Figure 9 : Choix de validité pour une plage de cellules
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Afficher la liste de sélection
Permet, lorsque la cellule est en saisie, de faire apparaître sur sa droite une flèche qui permet 
d'afficher, dans une liste déroulante, la liste des valeurs valides.

Trier les entrées dans l'ordre croissant
Permet, dans la liste de sélection, d'afficher les valeurs triées dans l'ordre croissant et sans les 
valeurs dupliquées. Si l'option n'est pas sélectionnée, les valeurs sont affichées telles que dans
la plage de cellules source.

Source
Saisissez ou sélectionnez la plage de cellules.

Liste
Saisissez la liste des valeurs possibles, séparées par un retour à la ligne.

Aide à la saisie
Pour fournir une aide à la saisie pour une cellule, utilisez l'onglet Aide à la saisie de la boîte de 
dialogue Validité (Figure 10).

Figure 10 : Définir une aide à la saisie pour une cellule

Afficher l'aide à la saisie lors de la sélection d'une cellule
Permet d'afficher un message d'aide à chaque fois que le focus se trouve dans la cellule.

Titre
Titre du message à afficher.

Aide à la saisie
Contenu du message à afficher.

Message d'erreur
Pour déterminer l'action à effectuer et afficher un message d'erreur quand une valeur incorrecte 
est saisie, utilisez l'onglet Message d'erreur (Figure 11). Essayez d'écrire une remarque pertinente,
expliquant ce qu'une saisie valide devrait contenir, et pas simplement “Données incorrectes. 
Réessayez” ou quelque chose de ce genre.
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Figure 11 : Définir un message d'erreur pour une cellule avec une donnée incorrecte

Afficher un message d'erreur en cas de saisie de valeurs incorrectes
Permet d'afficher un message d'erreur si le critère de validité n'est pas respecté lors de la 
saisie d'une valeur dans la cellule.

Action
Permet de choisir l'action à effectuer en cas de saisie incorrecte :

• Arrêter : affiche une boîte de dialogue avec le message d'erreur. Vous ne pouvez que 
cliquer sur OK, ce qui annule la saisie que vous venez d'effectuer.

• Avertissement et Information : affiche une boîte de dialogue avec le message d'erreur. 
Vous pouvez cliquer sur OK, pour valider quand même la saisie que vous venez 
d'effectuer, ou cliquer sur Annuler pour l'annuler.

• Macro : exécute une macro si la saisie est incorrecte.

Parcourir
Si vous avez choisi d'exécuter une macro, permet d'ouvrir la boîte de dialogue Sélecteur de 
macro pour choisir la macro à exécuter.

Titre
Saisissez le titre de la boîte de dialogue qui apparaîtra en cas de saisie incorrecte. Le titre par 
défaut est LibreOffice Calc.

Message d'erreur
Saisissez le message de la boîte de dialogue qui apparaîtra en cas de saisie incorrecte. Le 
message par défaut est Valeur incorrecte.

Audit
L'outil Audit vous permet de mettre en évidence les cellules dont le contenu ne répond pas aux 
critères de validation. Ceci peut se produire si l'action en cas d'erreur est un avertissement ou une 
information, ou si vous avez défini une validation pour des cellules contenant une fonction : le 
contrôle de validité ne se déclenchera pas lors du calcul.

Choisissez Outils > Audit > Marquer les données incorrectes depuis la barre de menus pour 
trouver les cellules avec des données incorrectes. La fonction Audit marque chaque cellule 
contenant des données incorrectes avec un ovale (Figure 12).
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Figure 12 : Données incorrectes marquées par la fonction Audit

Modifier les données

La modification des données se fait en gros de la même manière que leur saisie. La première 
étape est de sélectionner la cellule contenant les données à modifier.

Supprimer les données d'une cellule
Les données d'une cellule peuvent être effacées (supprimées) de plusieurs façons.

Supprimer les données seulement
Les données seules peuvent être supprimées dans une cellule sans affecter le formatage de la
cellule. Cliquez dans la cellule pour la sélectionner et appuyez ensuite sur la touche Suppr.

Supprimer les données et le formatage
Les données et le formatage peuvent être supprimés d'une cellule en une seule fois. Appuyez 
sur la touche Retour arrière (ou faites un clic droit et choisissez Supprimer du contenu, ou 
utilisez Édition > Supprimer du contenu) pour ouvrir la boîte de dialogue Supprimer du 
contenu (Figure 13). Dans cette boîte de dialogue, plusieurs attributs de la cellule peuvent être 
supprimés. Pour tout supprimer dans une cellule (contenu et format), cochez Tout supprimer.

Figure 13 : Boîte de dialogue Supprimer du 
contenu

Note
Si vous choisissez Héritage OpenOffice.org comme Raccourci clavier dans l'option
Outils > Options > LibreOffice Calc > Compatibilité, le comportement des 
touches Suppr et Retour arrière est inversé.
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Remplacer toutes les données dans une cellule
Pour supprimer les données et insérer de nouvelles données, tapez simplement par-dessus les 
anciennes données. Les nouvelles données conserveront le format d'origine.

Changer une partie des données dans une cellule
Il est parfois nécessaire de changer le contenu d'une cellule sans en supprimer tout le contenu, 
par exemple quand la phrase “Jean va partir” se trouve dans une cellule et doit être changée en 
“Jean va partir demain.” Il est souvent utile de le faire sans tout d'abord supprimer l'ancien contenu
de la cellule.

La méthode est similaire à celle décrite ci-dessus, mais vous devez placer le curseur dans la 
cellule. Vous pouvez le faire de deux manières.

Utiliser le clavier
Après avoir sélectionné la cellule désirée, appuyez sur la touche F2 et le curseur sera placé à 
la fin de la cellule. Utilisez alors les flèches du clavier pour déplacer le curseur dans le texte de 
la cellule.

Utiliser la souris
Double-cliquez dans la cellule voulue (pour la sélectionner et placer le curseur à l'intérieur pour
modification), ou cliquez pour sélectionner la cellule et ensuite déplacez le pointeur de la souris
dans la ligne de saisie et cliquez à l'intérieur pour placer le curseur pour modification.

Collage spécial dans une cellule

Vous pouvez utiliser la fonction de collage spécial pour ne recopier dans une cellule qu'une partie 
d'une cellule d'origine, son format ou le résultat brut de sa formule par exemple. Pour ceci, vous 
devez copier une cellule ou une plage dans le presse-papiers. Ensuite, vous pouvez sélectionner 
la cellule ou la plage de destination et :

• sélectionner Édition > Collage spécial depuis la barre de menus ;

• appuyer sur Ctrl+Maj+V ;

• faire un clic droit et sélectionner Collage spécial dans le menu contextuel.

La boîte de dialogue Collage spécial (Figure 14) apparaît.

Si vous conservez les options par défaut, le collage spécial équivaut à un collage normal. Vous 
pouvez décocher l'option Tout insérer et choisir les éléments pour ne recopier qu'une partie de la 
cellule d'origine.

Au lieu d'écraser le contenu d'une cellule, vous pouvez effectuer une des quatre opérations 
arithmétiques entre les contenus des cellules d'origine et de destination.

L'option Ignorer les cellules vides permet que les cellules vides du presse-papiers n'écrasent pas 
les cellules de destination. L'option Transposer fait que les lignes de cellules deviennent des 
colonnes, et vice-versa. L'option Lier permet d'insérer dans les cellules de destination non pas une
valeur, mais une formule vers la cellule d'origine, à condition que cette dernière soit non vide.

Vous pouvez insérer les cellules d'origine et déplacer les cellules de destination vers le bas ou 
vers la droite.

Il existe des commandes simplifiées de collage spécial dans le menu contextuel d'une cellule. Pour
ceci, faites un clic droit et choisissez Coller seulement > Texte, Nombre ou Formule.
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Figure 14 : Boîte de dialogue Collage spécial

Insérer un champ dans une cellule
Vous pouvez insérer dans une cellule un champ correspondant à la date du jour, au nom de la 
feuille ou au nom du document. La cellule doit être en cours de modification. Pour ceci, placez le 
curseur dans la cellule comme décrit dans le sujet "Changer une partie des données dans une 
cellule". Faites alors un clic droit, puis, dans le menu contextuel, choisissez Insérer des champs >
Date ou Nom de feuille ou Titre.

Attention
Si la propriété Titre n'a pas été définie, la commande Insérer des champs > Titre 
va insérer dans la cellule le nom du fichier.

Astuce
Les champs sont actualisés lors de l'enregistrement du classeur ou via le raccourci
clavier Ctrl+Maj+F9.

Formater les données

Les données dans Calc peuvent être formatées de plusieurs façons. Le formatage peut soit faire 
partie d'un style de cellules qui sera appliqué automatiquement, soit être appliqué manuellement à 
la cellule. Certains formatages manuels peuvent être appliqués en utilisant les icônes de barre 
d'outils. Pour plus de contrôles et d'options supplémentaires, sélectionnez la cellule ou la plage de 
cellules voulue, faites un clic droit à l'intérieur et sélectionnez Formater les Cellules. Toutes les 
possibilités de formatage sont abordées ci-dessous.
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Note
Tous les paramétrages abordés dans cette section peuvent aussi être effectués en
tant qu'éléments d'un style de cellule. Voir Chapitre 4 (Utiliser les styles et les 
modèles) pour plus d'informations.

Formater plusieurs lignes de texte
Des lignes de texte multiples peuvent être saisies dans une seule cellule en utilisant le renvoi à la 
ligne automatique ou des retours à la ligne manuels. Chaque méthode est utile dans différentes 
situations.

Utiliser le retour à la ligne automatique
Pour que le texte revienne à la ligne en fin de cellule, faites un clic droit et sélectionnez Formater 
les cellules (ou choisissez Format > Cellules depuis la barre de menus, ou appuyez sur Ctrl+1). 
Dans l'onglet Alignement (Figure 15), sous Propriétés, cochez Renvoi à la ligne automatique. Le 
résultat est montré ci-dessous (Figure 16).

Figure 15 : Boîte de dialogue Formatage des cellules > Alignement

Figure 16 : Retour à la ligne automatique
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Utiliser les sauts de ligne manuels
Pour insérer un saut de ligne manuel pendant la frappe dans une cellule, appuyez sur Ctrl+Entrée.
Pour insérer un saut de ligne dans un texte déjà saisi, double-cliquez dans la cellule à l'endroit où 
vous voulez faire un saut de ligne (il est aussi possible de cliquer dans la ligne de saisie à l'endroit 
concerné) avant d'appuyer sur Ctrl+Entrée.

Quelle que soit la méthode (renvoi à la ligne automatique ou saut de ligne manuel), la hauteur de 
ligne est adaptée mais la largeur de cellule ne change pas. La Figure 17 montre le résultat de la 
saisie de deux sauts de ligne manuels après la première ligne de texte.

Figure 17 : Cellule avec sauts de ligne manuels

Ajuster le texte à la taille de la cellule
La taille de police des données d'une cellule peut être automatiquement ajustée pour remplir la 
cellule. Pour le faire, cochez l'option Ajuster à la taille de la cellule dans la boîte de dialogue 
Formater les cellules (Figure 15). La Figure 18 montre le résultat.

Figure 18 : Ajustement de la taille de police à la cellule

Formater les nombres
Plusieurs formats de nombres différents peuvent être appliqués aux cellules en utilisant les icônes 
de la barre d'outils Formatage. Sélectionnez la cellule, puis cliquez sur l'icône correspondante. 
Certaines icônes peuvent ne pas être visibles avec le réglage par défaut ; faites un clic droit sur la 
barre puis choisir Boutons visibles et sélectionnez les icônes à afficher.

Figure 19 : Icônes de formats de nombres. De gauche à droite : monnaie, pourcentage, 
date, scientifique, standard, ajouter une décimale, supprimer une décimale

Depuis Calc 3.3, les nombres formatés avec le format de nombre Standard sont affichés avec 
autant de décimales que nécessaire. Avec les versions plus anciennes de Calc, un maximum de 2 
décimales était affiché avec ce format. Vous pouvez reproduire ce mode de fonctionnement en 
sélectionnant Outils > Options > LibreOffice Calc > Calcul et en choisissant Limiter les 
décimales pour le format de nombre général.
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Figure 20 : Formatage des cellules > Nombres

Pour plus de contrôle ou pour sélectionner d'autres formats de nombres, utilisez l'onglet Nombres 
(Figure 20) de la boîte de dialogue Formatage des cellules :

• Appliquez l'un des types de données de la liste Catégorie aux données.

• Contrôlez le nombre de décimales et de zéros non significatifs.

• Saisissez une description de format personnalisée.

Le paramètre Langue détermine les paramètres locaux pour les différents formats comme l'ordre 
dans les dates et le symbole de l'unité monétaire.

Formater la police
Pour choisir rapidement la police utilisée dans une cellule, sélectionnez la cellule, puis cliquez sur 
la flèche près du champ Nom de police dans la barre d'outils Formatage et choisissez une police 
dans la liste.

Astuce

Pour choisir d'afficher les noms de police dans leur police ou en texte simple, allez
dans Outils > Options > LibreOffice > Affichage et cochez ou décochez 
Afficher l'aperçu des polices dans la section Liste des polices. Pour plus 
d'informations, voir Chapitre 14 (Paramétrer et personnaliser Calc).

Pour choisir la taille de la police, cliquez sur la flèche près du champ Taille de police dans la barre
d'outils Formatage. Pour d'autres formats, vous pouvez utiliser les icônes Gras, Italique ou 
Soulignage.
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Vous pouvez également utiliser l'onglet Police de la boîte de dialogue Formatage des cellules 
(Figure 21).

Figure 21 : Formatage des cellules > Police

Vous pouvez ici spécifier la langue de la cellule, ce qui est utile pour permettre à plusieurs langues 
d'exister dans un même document et d'être vérifiées correctement (orthographe).

Choisir les effets de caractères
L'onglet Effets de caractères (Figure 22) de la boîte de dialogue Formatage des cellules offre plus 
d'options concernant la police.

Couleur de police
Si vous choisissez Automatique, la couleur de la police sera noire pour les arrière-plans clairs 
et blanche pour les arrière-plans foncés.

Pour choisir une couleur de police, vous pouvez aussi cliquer sur la flèche près de l'icône 
Couleur de police pour afficher la palette des couleurs. Cliquez alors sur la couleur voulue. 
Pour définir des couleurs personnalisées, utilisez Outils > Options > LibreOffice > Couleurs. 
Voir Chapitre 14 pour plus d'informations.

Surlignage et soulignage
Vous pouvez choisir parmi plusieurs sortes de surlignage et de soulignage (lignes continues, 
pointillés, tirets courts et longs, dans de multiples combinaisons) et la couleur de la ligne. Vous 
pouvez cocher Mot par mot pour surligner ou souligner les mots individuellement.

Barré
Vous pouvez barrer le contenu avec des lignes, des slash et des X.

Relief
Les possibilités de relief sont : relief (texte surélevé), empreinte (texte enfoncé), contour et 
ombre.
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Figure 22 : Formatage des cellules > Effets de caractères

Paramétrer l'alignement et l'orientation des cellules
Certaines des icônes d'alignement et d'orientation des cellules ne sont pas affichées par défaut 
dans la barre d'outils Formatage. Pour les afficher, faites un clic droit sur la barre puis choisir 
Boutons visibles et sélectionnez les icônes à afficher.

Figure 23 : Alignement et orientation des 
cellules

Certaines des icônes d'alignement et d'orientation ne sont accessibles que si vous avez activé les 
langues asiatiques ou l'écriture bidirectionnelle (dans Outils > Options > Paramètres 
linguistiques > Langues). Si vous choisissez dans la liste une icône non disponible, elle 
n’apparaîtra pas dans la barre d'outils.

Pour plus de contrôle et de choix, utilisez l'onglet Alignement (Figure 15) de la boîte de dialogue 
Formatage des cellules pour déterminer l'alignement horizontal et vertical et donner une rotation 
au texte.
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Si vous avez activé les langues asiatiques, la section Orientation du texte comporte alors une case
à cocher supplémentaire (Mode de mise en page asiatique) sous la case Empilé verticalement,
comme Figure 24. La différence de résultat entre Mode de mise en page asiatique coché ou non 
est montrée Figure 25.

Figure 24 : Options d'affichage des langues asiatiques

Figure 25 : Types 
d'empilements verticaux

Si vous avez activé les langues asiatiques, l'onglet Typographie asiatique est ajouté dans la boîte 
de dialogue. Cet onglet permet d'appliquer la liste des caractères interdits en début et en fin de 
ligne.

Si vous avez activé l'écriture bidirectionnelle, le paramètre Direction du texte vous permet de 
spécifier si le texte est écrit de gauche à droite ou de droite à gauche.

Formater les bordures des cellules
Pour choisir rapidement un style de ligne et une couleur pour les bordures d'une cellule, cliquez 
sur la petite flèche près des icônes Bordures, ajouter des lignes, Style de ligne et Couleur de 
ligne dans la barre d'outils Formatage. Si les icônes Bordures, ajouter des lignes, Style de 
ligne et Couleur de ligne ne sont pas affichées dans la barre d'outils Formatage, faites un clic 
droit sur la barre puis choisissez Boutons visibles et sélectionnez les icônes à afficher. Dans 
chaque cas, une palette de choix est affichée.

L'icône Bordures, ajouter des lignes fait apparaître la palette Bordures. Si vous cliquez sur une 
icône de cette palette, vous ajoutez les bordures correspondantes aux bordures déjà existantes de
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la cellule. Si vous cliquez sur une icône de cette palette en gardant appuyée la touche Maj, vous 
supprimez les bordures existantes de la cellule, puis vous ajoutez celles correspondant à l'icône.

Pour plus de contrôle, comme l'espacement entre les bordures de la cellule et le texte, 
sélectionnez la cellule et utilisez l'onglet Bordures de la boîte de dialogue Formatage des cellules 
(Figure 26).

Figure 26 : Formatage des cellules > Bordures

Disposition des lignes
• Par défaut : choisissez un style de bordure prédéfini.

• Défini par l'utilisateur : cliquez dans l'aperçu pour définir votre propre style de bordure. 
Vous pouvez cliquer sur chacune des lignes de côté et chacune des lignes diagonales. 
Cliquez successivement sur une ligne pour ajouter une bordure (apparence du trait), 
conserver la bordure existante (trait en grisé) ou supprimer une bordure (vide).

Ligne
Choisissez le style, la largeur et la couleur de la ligne de bordure.

Espacement avec le contenu
Indiquez l'espace que vous voulez laisser entre la bordure d'une cellule et son contenu. 
L'option Synchroniser permet d'appliquer le même espacement des quatre côtés de la cellule.

Style d'ombre
Choisissez la position, la largeur et la couleur de l'ombre que vous voulez appliquer à la cellule.

Si vous avez sélectionné une plage de cellules, et non pas une cellule individuelle, les dispositions 
de ligne par défaut et l’aperçu des bordures définies par l'utilisateur seront différents (Figure 27). 
Vous pouvez alors distinguer les bordures de la plage de cellules des bordures de chaque cellule 
individuelle.
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Figure 27 : Bordures d'une plage de cellules

Note

Les propriétés de bordure de cellule s'appliquent à une cellule, et ne peuvent être 
modifiées que dans cette cellule. Par exemple, si la cellule C3 a une bordure 
haute (ce qui est visuellement équivalent à une bordure basse dans C2), cette 
bordure ne pourra être supprimée qu'en sélectionnant C3. Elle ne pourra pas être 
supprimée dans C2.

Formater l'arrière-plan des cellules
Pour choisir rapidement une couleur d'arrière-plan pour une cellule, cliquez sur la petite flèche 
près de l'icône Couleur d'arrière-plan dans la barre d'outils Formatage. Une palette de choix de 
couleurs, identique à la palette Couleur de police, est affichée.

Pour définir des couleurs personnalisées, utilisez Outils > Options > LibreOffice > Couleurs. 
Voir Chapitre 14 pour plus d'informations.

Vous pouvez également utiliser l'onglet Arrière-plan de la boîte de dialogue Formatage des 
cellules.

Mise en évidence des valeurs

Cette fonction affiche le contenu des cellules avec des couleurs différentes selon le type de 
données.

Sélectionnez Affichage > Mise en évidence des valeurs depuis la barre de menus, ou appuyez 
sur Ctrl+F8, pour activer ou désactiver cette fonction.

Les cellules de texte sont formatées en noir, les nombres en bleu et les formules en vert, quel que 
soit le formatage de cellule qui a été défini. Si cette fonction est active, les couleurs que vous avez 
définies pour le document ne seront pas affichées. Lorsque vous désactivez cette fonction, les 
couleurs définies par les utilisateurs réapparaissent.

Cette fonction peut également être activée en sélectionnant Outils > Options > LibreOffice Calc 
> Affichage et en cochant l'option Mise en évidence des valeurs. Cette action va appliquer la mise
en évidence des valeurs à chaque fois que vous ouvrirez Calc, ce qui n'est peut-être pas ce que 
vous souhaitez.
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Attention
Si vous avez sélectionné Affichage > Mise en évidence des valeurs, lors d'une 
impression ou d'un aperçu avant impression, la fonctionnalité est désactivée et les
couleurs du formatage sont utilisées. Ce n'est pas le cas si vous avez utilisé 
l'option Mise en évidence des valeurs de Outils > Options > LibreOffice Calc > 
Affichage.

Autoformatage des cellules et des feuilles

Vous pouvez utiliser la fonctionnalité AutoFormat pour appliquer rapidement un ensemble de 
formats de cellules à une feuille ou une plage de cellule sélectionnée.

1) Sélectionnez les cellules que vous voulez formater, avec les en-têtes de colonnes et de 
lignes.

2) Choisissez Format > AutoFormat.

3) Sélectionnez le format souhaité dans la liste.

4) Pour sélectionner quelles propriétés (format de nombres, police, alignement, bordures, 
motif, ajustement de la largeur et de la hauteur) sont à inclure dans un AutoFormat, cliquez
sur Plus. Cochez ou décochez les options voulues. Cliquez sur OK.

Si vous ne voyez pas de changement de couleur du contenu des cellules, vérifiez si Affichage > 
Mise en évidence des valeurs n'est pas coché.

Note
Si la plage de cellules ne contient pas au moins 3 x 3 cellules, AutoFormat n'est 
pas disponible.

Figure 28 : Choisir un AutoFormat

Définir un nouvel AutoFormat
Vous pouvez définir un nouvel AutoFormat disponible pour tous les classeurs.

1) Formatez une feuille.
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2) Sélectionnez la plage de données définissant le nouvel AutoFormat, d'une dimension 
minimum de 4 x 4 cellules, ou choisissez Édition > Tout sélectionner.

3) Choisissez Format > AutoFormat. Le bouton Ajouter est maintenant actif.

4) Cliquez sur Ajouter.

5) Dans le champ Nom de la boîte de dialogue Ajouter un AutoFormat, tapez un nom 
significatif pour le nouveau format.

6) Cliquez sur OK pour enregistrer. Le nouveau format est désormais valable dans la liste 
Format de la boîte de dialogue AutoFormat.

Formater les classeurs en utilisant les thèmes

Calc est fourni avec un ensemble prédéfini de thèmes de formatage que vous pouvez appliquer à 
vos classeurs.

Il n'est pas possible d'ajouter des thèmes dans Calc, et ils ne peuvent pas être modifiés. 
Cependant, vous pouvez modifier leurs styles une fois que vous les aurez appliqués à un classeur.

Pour appliquer un thème à un classeur :

1) Cliquez sur l'icône Sélectionner des thèmes  dans la barre d'outils Outils. Si cette 
barre d'outils n'est pas visible, vous pouvez l'afficher en utilisant Affichage > Barres 
d'outils > Outils. La boîte de dialogue Sélection de thème apparaît. Cette boîte de 
dialogue liste les thèmes disponibles pour tout le classeur.

2) Dans la boîte de dialogue Sélection de thème, sélectionnez le thème que vous voulez 
appliquer au classeur. Dès que vous avez sélectionné un thème, certaines des propriétés 
des styles personnalisés sont appliquées au classeur ouvert et sont immédiatement 
visibles.

3) Cliquez sur OK. Si vous le souhaitez, vous pouvez alors aller dans la fenêtre Styles et 
formatage pour modifier certains styles (voir Chapitre 4 pour plus de détails). Ces 
modifications ne changent pas le thème ; elles changent uniquement l’apparence de ce 
classeur particulier.

Utiliser le formatage conditionnel

Vous pouvez paramétrer le formatage des cellules pour qu'il change selon les conditions que vous 
spécifiez. Par exemple, dans un tableau de nombres, vous pouvez afficher toutes les valeurs au-
dessus de la moyenne en vert et celles en dessous de la moyenne en rouge.

Note
Pour appliquer un formatage conditionnel, Calculer automatiquement doit être 
activé. Choisissez Outils > Contenu des cellules > Calculer automatiquement.

Le formatage conditionnel est lié à l'utilisation des styles. Si vous n'êtes pas familier des styles, 
référez-vous au Chapitre 4. Une manière facile de paramétrer les styles voulus est de formater une
cellule comme vous le voulez et cliquer sur l'icône Nouveau style à partir de la sélection dans la 
fenêtre Styles et formatage.

Une fois les styles paramétrés, voici comment les utiliser :

1) Dans votre classeur, sélectionnez les cellules auxquelles vous voulez appliquer un 
formatage conditionnel.

2) Choisissez Format > Formatage conditionnel > Condition, Échelle de couleur, Barre 
de données ou Date dans la barre de menus. La boîte de dialogue Formatage 
conditionnel s'ouvre et affiche la liste des conditions déjà définies.
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3) Cliquez sur Ajouter et saisissez la condition. Répétez cette étape autant que nécessaire.

4) Cliquez sur OK pour enregistrer. Les cellules sélectionnées sont désormais formatées 
dans le style correspondant.

Depuis Calc 3.5, avec le bouton Ajouter, vous pouvez ajouter autant de conditions que vous 
voulez pour votre formatage conditionnel. La Figure 29 illustre un formatage comportant trois 
conditions.

Reportez-vous à l'Aide pour plus d'informations et des exemples d'utilisation.

Formatage selon la valeur de la cellule
Vous pouvez définir une condition portant sur la valeur d'une cellule en choisissant, dans le 
premier champ de définition de la condition, La valeur de la cellule est. La condition se définit alors
comme Figure 29.

Figure 29 : Boîte de dialogue Formatage conditionnel selon la valeur de la cellule
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Pour chacune des conditions, vous pouvez saisir :

Condition de valeur
Choisissez des conditions comme inférieur à, supérieur à, entre parmi d'autres.

Si vous avez sélectionné une plage de cellules, vous pouvez appliquer un format particulier 
aux valeurs dupliquées ou non, ou supérieures ou inférieures à la moyenne des valeurs de 
cette plage. Vous pouvez également mettre en évidence les x valeurs supérieures ou 
inférieures, en valeur ou en pourcentage.

Champ paramètre
Saisissez une référence, une valeur ou une formule dans le champ paramètre, ou dans les 
deux champs paramètres si vous avez choisi une condition qui nécessite deux paramètres. 
Vous pouvez également saisir des formules contenant des références relatives ou absolues.

Style de cellule
Choisissez le style de cellule à appliquer si la condition spécifiée est remplie. Un aperçu du 
style choisi est alors visible. Vous pouvez définir un nouveau style en choisissant Nouveau 
style dans la liste déroulante. La boîte de dialogue Style de cellule est alors ouverte.

Formatage selon une formule
Vous pouvez définir une condition portant sur l'état Vrai ou Faux d'une formule en choisissant, 
dans le premier champ de définition de la condition, La formule est. La condition se définit alors 
comme Figure 30.

Figure 30 : Boîte de dialogue Formatage conditionnel selon une formule

Pour chacune des conditions, vous pouvez saisir :

Champ paramètre
Saisissez la formule à tester dans le champ paramètre. Si cette formule renvoie la valeur Vrai, 
le formatage sera appliqué. Vous pouvez saisir des formules contenant des références 
relatives ou absolues.

Style de cellule
Choisissez le style de cellule à appliquer si la formule est Vrai. Un aperçu du style choisi est 
alors visible. Vous pouvez définir un nouveau style en choisissant Nouveau style dans la liste 
déroulante. La boîte de dialogue Style de cellule est alors ouverte.

Formatage selon la date du jour
Vous pouvez définir une condition portant sur la date contenue dans une cellule par rapport à la 
date du jour en choisissant, dans le premier champ de définition de la condition, La date est. La 
définition se définit alors comme Figure 31.
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Figure 31 : Boîte de dialogue Formatage conditionnel selon une date

Pour chacune des conditions, vous pouvez saisir :

Champ paramètre
Saisissez la condition de date à tester dans le champ paramètre, comme Aujourd'hui, Les 7 
derniers jours ou Le mois prochain, par exemple.

Style de cellule
Choisissez le style de cellule à appliquer si la formule est Vrai. Un aperçu du style choisi est 
alors visible. Vous pouvez définir un nouveau style en choisissant Nouveau style dans la liste 
déroulante. La boîte de dialogue Style de cellule est alors ouverte.

Formatage d'une plage de cellules avec une échelle de couleurs
Vous pouvez définir une condition portant sur une plage de cellules pour produire une échelle de 
couleurs en choisissant, dans le premier champ de définition de la condition, Toutes les cellules, 
et, dans le deuxième, Échelle de couleurs (2 entrées) ou Échelle de couleurs (3 entrées). La 
condition se définit alors comme Figure 32.

Figure 32 : Boîte de dialogue Formatage conditionnel pour une échelle de couleurs 
(2 entrées)

Le résultat est semblable à celui de la Figure 33.

Figure 33 : Échelle de couleurs (2 entrées)

Formatage d'une plage de cellules avec une barre de données
Vous pouvez définir une condition portant sur une plage de cellules pour produire une barre de 
données en choisissant, dans le premier champ de définition de la condition, Toutes les cellules, 
et, dans le deuxième, Barre de données. La condition se définit alors comme Figure 34.
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Figure 34 : Boîte de dialogue Formatage conditionnel pour une barre de données

Vous pouvez cliquer sur le bouton Plus d'options pour afficher la boîte de dialogue Barre de 
données (Figure 35), qui contient des paramètres supplémentaires.

Figure 35 : Boîte de dialogue Barre de données

Le résultat est alors semblable à celui de la Figure 36.

Figure 36 : Barre 
de données
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Formatage d'une plage de cellules avec un jeu d'icônes
Vous pouvez définir une condition portant sur une plage de cellules pour ajouter une série d'icônes
en choisissant, dans le premier champ de définition de la condition, Toutes les cellules, dans le 
deuxième, Jeu d'icônes et, dans le troisième, le jeu d'icônes que vous voulez voir apparaître. La 
condition se définit alors comme Figure 37.

Figure 37 : Boîte de dialogue Formatage conditionnel pour un jeu d'icônes

Le résultat est alors semblable à celui de la Figure 38.

Figure 38 : Jeu 
d'icônes 3 flèches

Les conditions d'affichage de chaque icône peuvent être spécifiées par rapport à une valeur 
(Valeur), à un pourcentage du nombre de valeurs de la plage (Pourcentage), à un pourcentage 
des valeurs de la plage (Centile) ou à une formule (Formule).

Gestion des formatages conditionnels
Pour appliquer ensuite le même formatage conditionnel dans d'autres cellules :

1) Sélectionnez l'une des cellules où le formatage conditionnel a été appliqué.

2) Copiez la cellule dans le presse-papiers.

3) Sélectionnez les cellules que vous voulez voir formatées de la même façon.

4) Choisissez Édition > Collage Spécial.

5) Dans la boîte de dialogue Collage spécial, dans la zone Sélection, cochez uniquement 
l'option Formats. Assurez-vous que les autres options ne sont pas cochées. Cliquez sur 
OK.

Vous pouvez voir l'ensemble des formatages conditionnels définis dans votre feuille en choisissant
Format > Formatage conditionnel > Gérer dans la barre de menus. La boîte de dialogue Gérer 
le formatage conditionnel s'ouvre, comme Figure 39. Vous pouvez à cet endroit ajouter, éditer ou 
supprimer un formatage.

Si vous avez défini un format conditionnel sur une plage de cellules et que vous essayez de définir
un nouveau format conditionnel sur une partie de cette plage, un message d'avertissement 
s'affiche, vous demandant si vous voulez éditer le format conditionnel existant (sur la totalité de la 
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plage initiale) ou définir un nouveau format conditionnel le chevauchant (sur la plage de cellules 
sélectionnée).

Figure 39 : Boîte de dialogue Gérer le formatage conditionnel

Masquer et afficher les données

Quand des éléments sont masqués, ils ne sont ni visibles ni imprimables, mais ils peuvent toujours
être sélectionnés pour une copie si vous sélectionnez les éléments autour d'eux. Par exemple, si 
la colonne B est masquée, elle est copiée si vous sélectionnez les colonnes A et C. Quand vous 
avez à nouveau besoin d'un élément masqué, vous pouvez inverser le processus et afficher 
l'élément.

Pour masquer ou afficher les feuilles, les lignes ou les colonnes, utilisez les options du menu 
Format ou du menu contextuel (clic droit). Par exemple, pour masquer une ligne, sélectionnez tout 
d'abord la ligne et choisissez ensuite Format > Ligne > Masquer (ou faites un clic droit sur l'en-
tête et choisissez Masquer).

Pour masquer ou afficher des cellules, sélectionnez-les et choisissez Format > Cellules dans la 
barre de menus (ou faites un clic droit et choisissez Formater les cellules). Dans la boîte de 
dialogue Formater les cellules, allez à l'onglet Protection de cellule. Le masquage ne sera effectif 
qu'après avoir protégé la feuille par Outils > Protéger le document > Feuille.
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Figure 40 : Masquer ou afficher des cellules

Plans et groupes
Si vous masquez et affichez sans cesse les mêmes lignes ou colonnes, vous pouvez simplifier 
cette tâche en créant des groupes de lignes ou de colonnes, ce qui ajoute un ensemble de 
contrôles de plan pour masquer ou afficher les cellules d'un groupe qui sont faciles à utiliser et 
toujours disponibles.

Si la plage de cellules sélectionnée comporte des formules et si le contenu des cellules suit un 
schéma régulier, comme quatre cellules suivies d'un total, vous pouvez utiliser Données > Plan et 
groupe > AutoPlan pour que Calc ajoute des contrôles de plan selon le schéma. Sinon, vous 
pouvez faire un regroupement manuel en sélectionnant les cellules à grouper, puis en choisissant 
Données > Plan et groupe > Grouper ou en appuyant sur F12. Si vous n'avez pas sélectionné 
de lignes ou de colonnes, la boîte de dialogue Grouper apparaît et vous pouvez choisir de grouper 
les cellules sélectionnées en lignes ou en colonnes.

Après avoir fermé la boîte de dialogue, les contrôles de plan sont visibles entre les en-têtes soit de
lignes, soit de colonnes, et les bords de la fenêtre courante. Les contrôles de plan ressemblent à la
structure arborescente d'un gestionnaire de fichiers, et peuvent être fermés en sélectionnant 
Données > Plan et groupe > Masquer les détails. Ils sont réservés à un usage à l'écran et ne 
s'impriment pas.

Les contrôles de plan de base ont des signes plus ou moins au début d'un groupe pour afficher ou 
masquer des cellules. De plus, si les groupes sont imbriqués, les contrôles de plan comprennent 
des boutons avec des numéros pour masquer les différents niveaux.

Figure 41 : Contrôles de plan
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Si vous n'avez plus besoin d'un groupe, placez le curseur de la souris dans l'une de ses cellules et
sélectionnez Données > Plan et groupe > Dissocier ou appuyez sur Ctrl+F12. Pour supprimer 
tous les groupes d'une feuille, sélectionnez Données > Plan et groupe > Supprimer.

Filtrer quelles cellules sont visibles
Un filtre est une liste de conditions que chaque saisie doit remplir pour être affichée. Vous pouvez 
utiliser trois types de filtres dans le sous-menu Données > Filtre.

Autofiltres
Les Autofiltres ajoutent une liste déroulante à la ligne la plus haute d'une colonne, liste qui contient
les filtres les plus couramment utilisés. Ils sont rapides, pratiques et aussi utiles pour les textes que
pour les nombres, car la liste comprend l'ensemble des valeurs uniques se trouvant dans les 
cellules sélectionnées, triées dans l'ordre lexicographique. Vous pouvez vous positionner dans 
cette liste en tapant les caractères de début de la valeur que vous recherchez.

En plus de ces valeurs uniques, les filtres automatiques comprennent des options pour afficher 
toutes les valeurs, les 10 valeurs numériques les plus fortes, les valeurs vides ou non vides. 
Cependant, ils sont quelque part limités. En particulier, ils ne permettent pas l'usage des 
expressions régulières, et donc vous ne pouvez pas les utiliser pour afficher des contenus de 
cellules qui sont similaires, mais pas identiques. En revanche, ils permettent d'accéder directement
au filtre standard que vous pouvez personnaliser pour cela (voir ci-dessous).

Exemple simple d'utilisation :

Figure 42 : Liste à filtrer

1) Cliquez dans l'une des cellules de la liste, ou sélectionnez la plage de cellules (A1:E12 ici).

2) Sélectionnez Données > Filtre > AutoFiltre dans la barre de menus.

3) Des listes déroulantes apparaissent au sommet de chaque colonne.

4) Cliquez sur la flèche en haut de la colonne Employé et sélectionnez toutes les lignes de 
l'employé Yves en cliquant sur cette valeur dans la liste, puis en cliquant sur l'icône 
Afficher uniquement l'élément actif (voir Figure 43).
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Figure 43 : Sélection de l'employé Yves

5) La liste est filtrée et n'affiche que les lignes avec cette valeur. Les numéros des lignes qui 
correspondent sont affichés et les numéros des autres lignes sont masqués. La flèche en 
haut de la colonne choisie pour filtrer les données change de couleur et comporte un 
indicateur dans son coin inférieur droit (Figure 44).

Figure 44 : Lignes filtrées et flèche modifiée

6) Vous pouvez alors filtrer les données par Catégorie, pour n'afficher que les ventes d'articles
de golf, selon la même méthode que ci-dessus. La flèche en haut de la colonne indique 
également qu'elle est utilisée dans le filtre (Figure 45).

Figure 45 : Résultat de la sélection de la Catégorie Golf
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Les filtres peuvent être supprimés individuellement ou globalement.

• Pour supprimer tous les filtres, cliquez dans l'une des cellules de la liste, ou sélectionnez la
plage de cellules. Depuis la barre de menus, sélectionnez Données > Filtre > Supprimer 
le filtre. Les données reviennent à l'état non filtré.

• Pour supprimer le filtre d'une colonne, cliquez sur la flèche en haut de cette colonne, puis 
cochez Tout et cliquez sur OK.

Filtres standard
Les filtres standard sont plus complexes que les filtres automatiques. Vous pouvez paramétrer 
jusqu'à huit conditions dans un filtre, en les combinant avec les opérateurs ET et OU. Les filtres 
standard sont plus utiles pour les nombres, bien que quelques opérateurs conditionnels comme = 
et <> (différent) puissent également être utilisés pour les textes.

D'autres opérateurs conditionnels pour les filtres standard comprennent des options pour afficher 
les plus grandes ou les plus petites valeurs, ou un pourcentage d'entre elles. Utiles en eux-
mêmes, les filtres standard sont également intéressants pour affiner des filtres automatiques.

Pour obtenir le même résultat que pour les Autofiltres à partir des données de la Figure 42, vous 
pouvez définir un filtre standard de la façon suivante.

Figure 46 : Filtre standard

Opérateur
Choisissez l'opérateur logique ET ou OU pour relier deux critères de filtre.

Nom de champ
Choisissez dans la liste déroulante le nom du champ à filtrer. Si les noms ne sont pas 
disponibles, les identifiants des colonnes sont utilisés.
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Condition
Choisissez dans la liste déroulante l'opérateur de comparaison à utiliser entre le Nom du 
champ et la Valeur. Les conditions Le plus grand, Le plus petit, Le plus grand % et Le plus 
petit % vous permettent de filtrer x valeurs selon leur importance, à condition que ce soient des
valeurs numériques. Dans l'exemple de la Figure 42, pour filtrer les 3 ventes dont le montant 
est le plus élevé, choisissez la condition Le plus grand et la valeur 3.

Valeur
Choisissez dans la liste déroulante une valeur de comparaison parmi les valeurs existantes du 
champ. Vous pouvez choisir les valeurs Vide et Non vide : dans ce cas, la condition est inutile. 
Vous pouvez également saisir une valeur.

Respecter la casse
Indiquez si vous voulez que les majuscules et les minuscules soient différenciées lors du filtre.

Caractère générique
Indiquez si vous voulez utiliser ou non les caractères génériques dans la définition des critères 
de filtre. Pour plus d'informations sur les caractères génériques, voir "Utiliser les caractères 
génériques (expressions régulières)" page 47.

Si cette option est cochée, vous pouvez aussi utiliser EGAL (=) et NON EGAL (<>) dans la 
définition des filtres, ainsi que dans les fonctions suivantes : BDNBVAL, BDLIRE, EQUIV, 
NB.SI, SOMME.SI, RECHERCHE, RECHERCHEV et RECHERCHEH.

La plage contient des étiquettes de colonne
Indiquez si vous voulez inclure les étiquettes de colonnes dans le filtre ou les utiliser comme 
noms de champ.

Sans doublons
Indiquez si vous voulez exclure du filtre les lignes en double.

Copier le résultat vers
Choisissez cette option, puis indiquez la plage où vous voulez afficher les résultats du filtre. 
Vous pouvez également choisir une plage nommée dans la liste déroulante.

Conserver les critères de filtre
Si vous avez appliqué le filtre à une plage définie en tant que plage de base de données 
(Données > Définir la plage) et vous avez coché l'option Copier le résultat vers, vous 
pouvez conserver un lien entre la plage de destination du résultat du filtre et la plage d'origine. 
Ainsi, si les données sont mises à jour dans la plage de base de données d'origine et que vous
effectuez Données > Actualiser la plage, le résultat du filtre dans la plage de destination sera 
mis à jour.

Filtres spéciaux
Les filtres spéciaux ont une structure identique aux filtres standard. Limités également à huit 
conditions (en-têtes inclus), leurs critères ne sont pas saisis dans une boîte de dialogue, mais 
directement dans le classeur.

Pour filtrer les données de la Figure 42 de la même façon que ci-dessus :

1) Copiez les en-têtes de données dans une partie vide de la feuille.

2) Dans les cellules en dessous, insérez les données qui vont servir de filtre.

3) Pour que les filtres soient reliés par un ET, saisissez les données sous les en-têtes 
correspondants et sur la même ligne. Pour qu'ils soient reliés par un OU, saisissez les 
données sur des lignes différentes.
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Figure 47 : Deux valeurs de filtre reliées par ET

4) Cliquez dans l'une des cellules de la liste, ou sélectionnez la plage de cellules.

5) Sélectionnez Données > Filtre > Filtre spécial. La boîte de dialogue Filtre spécial s'ouvre.

6) Sélectionnez les données du filtre spécial. Si vous les sélectionnez avec la souris, H1:L2 
dans l'exemple, durant leur sélection, elles sont entourées en rouge. Une fois la sélection 
effectuée, les données sont entourées en bleu et la boîte de dialogue contient la référence 
absolue à ces données (Figure 48). Vous pouvez également saisir directement la référence
des données du filtre spécial, ici H1:L2.

Figure 48 : Filtre spécial

7) Cliquez sur OK.

Les options accessibles par le bouton Plus sont identiques à celles d'un filtre standard.

Trier des enregistrements

Le tri modifie la disposition des cellules dans la feuille. Dans Calc, vous pouvez utiliser 
simultanément plusieurs critères de tri, qui sont appliqués l'un après l'autre. Les tris sont pratiques 
quand vous cherchez un élément particulier, et sont encore plus puissants combinés aux filtres.

De plus, le tri est souvent utile quand vous ajoutez de nouvelles données. Quand une liste est 
longue, il est habituellement plus facile d'ajouter des données en bas de la feuille, plutôt que 
d'insérer des lignes à leur bonne place. Après avoir ajouté des données, vous pouvez les trier pour
mettre à jour la feuille.

Si les données sont disposées en colonne et comportent un en-tête au format texte,
vous pouvez utiliser le tri rapide. Pour ceci, mettez en surbrillance les cellules à trier,
puis cliquez sur les boutons de barre d'outils Tri croissant ou Tri décroissant. Vous
pouvez également, si un Autofiltre est défini, utiliser Tri croissant ou Tri décroissant accessibles 
à partir de la flèche en haut de la colonne que vous désirez.
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Figure 49 : Tri à partir de l'Autofiltre

Pour un tri plus élaboré, mettez en surbrillance les cellules à trier, puis sélectionnez Données > 
Trier pour ouvrir la boîte de dialogue Tri (Figure 50). Dans la boîte de dialogue, vous pouvez trier 
les cellules sélectionnées, dans l'ordre croissant (A-Z, 1-9) ou dans l'ordre décroissant (Z-A, 9-1).

Le nombre de clés de tri est illimité. La définition de la clé de tri 3 fait apparaître la clé de tri 4, et 
ainsi de suite.

Figure 50 : Choisir les critères et les ordres de tri

Astuce
Vous pouvez définir un ordre de tri personnalisé si les ordres alphanumériques 
fournis ne vous conviennent pas. Pour ce faire, voir “Définir une série de 
remplissage” page 11.

Dans l'onglet Options de la boîte de dialogue Tri (Figure 51), vous pouvez choisir les options 
suivantes.

Sensible à la casse
Pour deux entrées par ailleurs identiques, celle avec une lettre majuscule est placée avant 
celle avec une lettre minuscule dans la même position si le tri est décroissant ; si le tri est 
croissant, alors l'entrée avec une lettre majuscule est placée après celle avec une lettre 
minuscule dans la même position.

La plage contient des étiquettes de colonne
N'inclut pas les étiquettes de colonnes dans le tri.

Inclure les formats
Le formatage d'une cellule est déplacé avec son contenu. Si un formatage est utilisé pour 
distinguer différents types de cellules, alors utilisez cette option.
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Figure 51 : Options de tri

Activer le tri naturel
Prend en compte les nombres préfixés par une chaîne de caractères au lieu de s'en tenir au 
strict ordre alphanumérique. Vous pouvez avoir par exemple une plage de cellules contenant 
A1, A2, A3 …, A19, A20, A21. Si vous activez le tri naturel, vous obtiendrez un tri dans cet 
ordre. Si vous ne l'activez pas, vous obtiendrez A1, A10, A11 …, A19, A2, A20, A21, A3, A4 …, 
A9.

Copier le résultat du tri à
Détermine une adresse dans un classeur où copier le résultat du tri. Vous pouvez indiquer une 
référence, une plage de cellules nommée ou une plage de données.

Ordre de tri personnalisé
Sélectionnez le champ, puis choisissez dans la liste déroulante une des séries de remplissage 
définies dans Outils > Options > LibreOffice Calc > Listes de tri.

Langue
Sélectionnez dans la liste déroulante la langue selon laquelle vous voulez que les règles de tri 
soient appliquées. Selon la langue choisie, des options peuvent être disponibles.

Direction
Détermine si les lignes ou les colonnes sont triées. Par défaut, le tri se fait de haut en bas (tri 
de lignes).
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Rechercher et remplacer dans Calc

Calc propose deux façons de rechercher du texte dans un document : la barre d'outils Rechercher 
pour une recherche rapide et la boîte de dialogue Rechercher & remplacer.

Utiliser la barre d'outils Rechercher
Vous pouvez afficher ou masquer la barre d'outils Rechercher (Figure 52) en utilisant Affichage > 
Barres d'outils > Rechercher, en utilisant Édition > Rechercher ou en appuyant sur Ctrl+F.

Figure 52 : Barre d'outils Rechercher

Vous pouvez fermer cette barre d'outils en cliquant sur la croix rouge à gauche ou en appuyant sur
la touche Échap.

Tapez un terme à rechercher dans le champ Rechercher, et cliquez ensuite sur le bouton 
Rechercher le suivant (flèche vers le bas) ou Rechercher le précédent (flèche vers le haut). 
Pour trouver les autres occurrences de ce même terme, continuez de cliquer sur le bouton.

Utiliser la boîte de dialogue Rechercher & remplacer
Pour afficher la boîte de dialogue Rechercher & remplacer (Figure 53), utilisez le raccourci clavier 
Ctrl+H, choisissez Édition > Rechercher & remplacer dans la barre de menus ou sélectionnez 
l'icône Rechercher&Remplacer dans la barre d'outils Rechercher.

Dans les classeurs, vous pouvez rechercher des textes, des formules et des styles. Vous pouvez 
naviguer d'une occurrence à l'autre en utilisant Rechercher, ou vous pouvez mettre en surbrillance
toutes les cellules qui correspondent en une fois en utilisant Tout rechercher, puis appliquer un 
autre format ou remplacer le contenu de la cellule par un autre.

Les textes et les nombres dans les cellules peuvent avoir été saisis directement ou être le résultat 
d'un calcul. La méthode de recherche que vous allez utiliser dépend du type de données que vous 
recherchez.

Astuce

Le contenu des cellules peut être formaté de différentes façons. Par exemple, un 
nombre peut être formaté en Monétaire, pour être affiché avec le symbole de la 
devise. Vous voyez le symbole monétaire dans la cellule, mais vous ne pouvez pas
le rechercher sauf s'il a été appliqué via un style (cf. page 47).

Par défaut, Calc recherche dans la feuille courante. Pour rechercher dans toutes les feuilles d'un 
document, cliquez sur Plus d'options, puis cochez Recherchez dans toutes les feuilles.

Attention Utilisez Tout remplacer avec prudence ; sinon, vous pouvez vous retrouver avec 
des erreurs très gênantes. Une erreur avec Tout remplacer peut nécessiter une 
recherche manuelle et mot par mot pour la réparer, si elle n'est pas découverte à 
temps pour pouvoir l'annuler.
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Figure 53 : Boîte de dialogue Rechercher & remplacer 
étendue

Rechercher et remplacer des formules ou des valeurs
Vous pouvez utiliser la boîte de dialogue Rechercher & remplacer pour rechercher dans des 
formules ou dans les valeurs affichées qui résultent d'un calcul.

1) Pour ouvrir la boîte de dialogue Rechercher & remplacer, utilisez le raccourci clavier Ctrl+H
ou sélectionnez Édition > Rechercher & remplacer.

2) Cliquez sur Plus d'options pour étendre la boîte de dialogue.

3) Sélectionnez Formules ou Valeurs dans la liste déroulante Rechercher dans.

• Formules examine les parties des formules.

• Valeurs examine le résultat des calculs.

4) Tapez le texte que vous voulez rechercher dans le champ Rechercher.

5) Pour remplacer le texte par un texte différent, tapez le nouveau texte dans le champ 
Remplacer par.
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6) Une fois votre recherche paramétrée, cliquez sur Rechercher. Pour remplacer le texte, 
cliquez à la place sur Remplacer.

Rechercher et remplacer des textes
1) Ouvrez la boîte de dialogue Rechercher & remplacer, cliquez sur Plus d'options pour 

étendre la boîte de dialogue et sélectionnez Valeurs ou Remarques dans la liste déroulante
Rechercher dans.

2) Tapez le texte que vous voulez trouver dans le champ Rechercher.

3) Pour remplacer le texte par un texte différent, tapez le nouveau texte dans le champ 
Remplacer par.

4) Cliquez sur Rechercher, Tout rechercher, Remplacer ou Tout remplacer.

Quand vous cliquez sur Rechercher, Calc sélectionne la cellule suivante qui contient votre texte. 
Vous pouvez modifier le texte, puis cliquer à nouveau sur Rechercher pour avancer à la cellule 
suivante trouvée. Si vous fermez la boîte de dialogue, vous pouvez appuyer sur Ctrl+Maj+F pour 
trouver la cellule suivante sans ouvrir la boîte de dialogue.

Quand vous cliquez sur Tout rechercher, Calc sélectionne toutes les cellules qui contiennent 
votre saisie. Vous pouvez alors, par exemple, appliquer un style de cellules à toutes ces cellules 
en même temps.

L'option Respecter la casse indique s'il faut tenir compte du fait que des lettres soient en 
majuscules ou en minuscules pour la recherche.

L'option Cellules entières indique si le texte recherché doit être le contenu exact d'une cellule. 
Avec cette option, si vous recherchez la chaîne Calc, une cellule contenant le texte "Calc" sera 
trouvée, mais une cellule contenant le texte "Calcul" ne le sera pas.

L'option Rechercher des similarités permet de rechercher des textes similaires à une valeur. 
Cliquez sur le bouton à droite de cette option pour paramétrer ce type de recherche.

Rechercher et remplacer des styles de cellules
Pour modifier rapidement toutes les cellules d'un style donné (non désiré) avec un autre style 
(préféré) :

1) Dans la boîte de dialogue Rechercher & remplacer étendue, sélectionnez Rechercher des
styles. Les champs Rechercher et Remplacer par contiennent alors une liste de styles.

2) Sélectionnez les styles que vous voulez rechercher et remplacer.

3) Cliquez sur Rechercher, Tout rechercher, Remplacer ou Tout remplacer.

Utiliser les caractères génériques (expressions régulières)
Les caractères génériques (ou expressions régulières) sont des combinaisons de caractères qui 
indiquent à LibreOffice comment rechercher quelque chose. Les expressions régulières sont très 
puissantes, mais pas très intuitives. Elles peuvent faire économiser du temps et du travail en 
combinant de multiples recherches en une seule.

Pour utiliser les caractères génériques et les expressions régulières pendant une recherche et un 
remplacement :

1) Dans la boîte de dialogue Rechercher & remplacer, cliquez sur Plus d'options pour avoir 
plus de choix. Dans cette boîte de dialogue étendue, cochez Expressions régulières.

2) Tapez le texte à rechercher, comprenant les caractères génériques, dans le champ 
Rechercher et le texte de remplacement (s'il y a lieu) dans le champ Remplacer par. 

3) Cliquez sur Rechercher, Tout rechercher, Remplacer ou Tout remplacer (non 
recommandé).
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Astuce L'aide du logiciel décrit plusieurs expressions régulières et leur utilisation.

Les expressions régulières doivent suivre la syntaxe normalisée ICU. Vous pouvez en savoir plus 
sur ce moteur à l'adresse suivante (en anglais) : 
http://userguide.icuproject.org/strings/regexp#TOC-Regular-Expression-Métacaractères.

Les points suivants peuvent intéresser les utilisateurs de Calc :

• Dans Calc, les expressions régulières sont appliquées séparément à chaque cellule. Cela 
signifie qu'une recherche de s.c va trouver sac dans la cellule A1, mais ne va pas trouver s
dans la cellule A2 ni c (ou ac) dans la cellule A3. (L'expression régulière s.c signifie que le 
système va essayer de trouver s suivi de n'importe quel caractère suivi de c).

• Quand une correspondance est trouvée, la cellule entière est en surbrillance, mais seul le 
texte trouvé sera remplacé. Par exemple, la recherche de homme aura pour résultat de 
mettre en surbrillance une cellule qui contient gentilhomme campagnard, et ne rien 
choisir dans le champ Remplacer par laissera la cellule avec gentil campagnard.

• Si Rechercher est utilisée deux fois à la suite, et si la seconde fois Sélection active 
seulement est cochée, alors la seconde recherche sera évaluée dans la totalité de chaque
cellule sélectionnée, et non uniquement dans la chaîne qui a fait que la cellule soit 
sélectionnée par la première recherche. Par exemple, la recherche de joh?n, puis 
l'activation de Sélection active seulement et la recherche de sm.th va trouver les cellules
contenant John Smith et Smythers, Johnathon.

• Si une cellule contient un saut de ligne manuel (entré par Ctrl+Entrée), il peut être trouvé 
en utilisant l'expression régulière \n. Par exemple, si une cellule contient mur[saut de 
ligne]porteur, une recherche de r\np sans rien dans le champ Remplacer par laissera la 
cellule avec muorteur.

• Le saut de ligne manuel agit également pour marquer une “fin de texte” (similaire à une “fin
de paragraphe” dans Writer), trouvé par le caractère spécial d'expression régulière $, en 
plus de la fin de texte dans une cellule. Par exemple, si une cellule contient mur[saut de 
ligne]porteur, alors une recherche de r$ remplacé par et laissera la cellule avec 
muet[saut de ligne]porteur. Notez qu'avec cette syntaxe, le saut de ligne n'est pas 
remplacé.

• L'utilisation de \n dans le champ Remplacer par va provoquer un remplacement par les 
caractères \n, et non par un saut de ligne.

• La boîte de dialogue Rechercher & remplacer a une option qui permet de rechercher dans 
des formules, des valeurs ou des remarques (pour rechercher dans les commentaires). 
Cette option s'applique à toutes les recherches, et non pas uniquement celles avec des 
expressions régulières. Une recherche de SOM avec l'option Formules va trouver une 
cellule contenant la formule =SOMME(A1:A6), ainsi qu'une cellule contenant le texte 
simple SOMMAIRE.

• Une recherche de l'expression régulière ^$ ne va pas trouver les cellules vides. C'est 
intentionnel, pour éviter les problèmes de performance quand on sélectionne un grand 
nombre de cellules. Notez que les cellules vides ne seront également pas trouvées si vous 
faites une recherche dans la sélection active seulement.

• Le fait de trouver les contenus de cellules en utilisant l'expression régulière .+ (ou similaire)
et de les remplacer par & va en pratique ressaisir le contenu des cellules sans formatage. 
Cette technique peut être utile pour supprimer le formatage automatiquement appliqué par 
Calc lors de l'importation de données depuis le presse-papier ou un fichier mal formaté. 
Par exemple, pour convertir les textes constitués de chiffres en nombres, formatez tout 
d'abord les cellules en nombres et faites ensuite la recherche et le remplacement.

Voir Chapitre 7 (Formules et fonctions) pour l'utilisation des expressions régulières dans les 
formules.
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